
 

FREQUENTLY ASKED QUESTIONS 
Q: Is DMS an online evaluation tool? 

Q. Who do I contact for help? 

Q: How much time will data entry require? 

Q: Who will enter my activities into the system? 

Q: How accurate is the data? 

Q: How do I enter special characters? 

Q: Do I have to enter data already collected in the Banner system? 

Q: How do I know which fields on a screen are required? 

Q: Can I enter data when I am away from campus? 

Q: What information will be made public or shared with other data bases?  

Q: How secure is my data? 

Q: Once my activities are in DMS, how might my information be used?    

Q: Who has access to my information in DMS? 

Q: Can anything be done to change the way certain information appears on the Vita? 

Q: How will cross-listed courses and multiple instructor courses appear in DMS?  

Q: DMS asks for both a publication accepted date and published date. Which is more important? 

Q: What is the difference between a working paper under Publications and an entry under 
Research Currently in Progress? 

Q: I've noticed that some of my citations on Books, Journals and Other Publication 
Contributions were entered by a collaborating faculty member. How does that work? 

Q: “Working Paper” appears as both a “Contribution Type” and “Current Status.”  What is the 
difference? 

Q: What about sensitive or proprietary information or intellectual property? 
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GENERAL 
Q: Is DMS an online evaluation tool? 

A: No. DMS is a data gathering and reporting tool that allows faculty to document their activities 
and to generate reports of their accomplishments for date ranges they specify.  DMS is not an 
online evaluation tool, although DMS reports can be generated to provide input to an evaluation 
process. Check with your department and/or school on specific performance evaluation 
procedures and requirements. 

Q. Who do I contact for help? 

A: You may contact your school’s administrator by selecting the Help menu in DMS. 
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DATA ENTRY 
Q: How much time will data entry require? 

A: That depends on the volume and complexity of the data you want to enter.  Generally, DM 
advises that you will need one hour for each year of activity. At W&M, experience shows that 
the time required increases greatly when others are tasked with entering data on your behalf 
because of the analysis needed to properly categorize records for the scholarship screens. 

  

Q: Who will enter my activities into the system? 

A: The system is designed for faculty to maintain their own records.  Where possible, 
screens/fields have been pre-populated with data from Banner.  The extent to which you will 
enter your own CV data varies by school/department/program.  Contact your school’s 
administrator using the Help menu in DMS. 

Q: How accurate is the data? 

A: What goes in to DMS is what comes out, typos and mistakes included, so review your 
entries for accuracy. You should update your data periodically so that time-sensitive information 
is correct.  For example, when a proposed publication is accepted for publication, you need to 
update DMS to reflect its new status. The accuracy of the information in DMS is particularly 
important if and when your school chooses to link your DMS data to your individual faculty 
webpage. These links will be real time so that citations you enter into DMS will be displayed 
immediately on your webpage. 
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Q: How do I enter special characters? 
 
A: Digital Measures offers the following advice on entering special characters into DMS 
(September 2014) 
“You may copy and paste special characters – such as Greek or Latin characters, accent marks or 
other diacritical marks – into Activity Insight from another source, as long as they are Unicode-
compliant. Unicode is an industry-standard set of characters that allows computers to 
consistently represent and manipulate text expressed in any of the world's writing systems. For 
more information about Unicode, please see: http://www.unicode.org/faq/basic_q.html. 
Examples of fonts that are Unicode-compliant include Arial and Times New Roman. Examples 
of fonts that are not Unicode-compliant include Symbol and Wingdings. If characters are not 
transferring to Activity Insight as you expect, try changing their font in the source software 
application to Arial or Times New Roman and then copy and paste the text into Activity Insight. 
For characters typically entered as symbols, you may need to change the underlying font of the 
character, in addition to the display font. To do this in Microsoft Word, navigate to Insert > More 
Symbols, and update the font of the symbol to a Unicode-compliant font prior to selecting and 
inserting the desired character. This ensures that the underlying font and the display font are 
Unicode-compliant, and that the symbols render correctly in Activity Insight. 
Note: Mac and PC versions of Microsoft Word often differ in how they convert special 
characters when switching to a Unicode-compliant font. The PC version of Word will copy 
special characters as images, which means you cannot transfer them into Activity Insight unless 
you replace them with symbols in a Unicode font. Defining the font for the symbol separately 
from the font of the text, as defined above, becomes important. The Mac version of Word 
converts the special character to a matching special character in the Unicode-compliant font, 
allowing you to transfer the character into Activity Insight.” 
 

Q: Do I have to enter data already collected in the Banner system? 

A: Each term, faculty information and courses taught are imported from Banner into the DMS 
forms Personal & Contact Information (PCI), Permanent Data, Yearly Data and Scheduled 
Teaching (Banner imports). 

NOTE:  Data imported from the Banner system will not be edited by faculty.  Changes should be 
discussed with your school’s administrator and routed appropriately to ensure the source data is 
updated in Banner. 
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Q: How do I know if a data fields is required? 
 
A: Required fields are marked with a red asterisk (*). However, we strongly encourage you to 
enter data as completely as possible allowing you to show the full scope of your work. Entering a 
year is critical to proper reporting. 
 
NOTE: School of Business faculty must also complete AACSB labeled fields. 
 
Q: Can I enter data when I am away from campus? 

A: Yes, DMS is available to you as long as you have an internet connection.  As of January 
2016, DMS supports Google Chrome, Mozilla Firefox, Apple Safari (Mac), Microsoft Internet 
Explorer (Windows), and Microsoft Edge (Windows). 
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PRIVACY 
Q: What information will be made public or shared with other data bases?  

A: Schools may choose to use DMS’s web services feature, which makes it possible to update 
faculty profiles on the web with information directly from DMS.  The information doesn’t 
change; it just allows for shared information to be captured and maintained in one system. You 
can contact your administrator for more details by selecting Help menu in DMS.  

 

Q: How secure is my data? 

A: For a full list of security features, you can visit the Security page 
at http://www.digitalmeasures.com/ActivityInsight/secure.htm   

 

Q: Once my activities are in DMS, how might my information be used? 

A: DMS’ flexibility allows for collected information to be conveyed in a variety of ways, such 
as: 

• reporting by faculty for their own uses, such as generating Vita, annual reports or 
Retention, Promotion and Tenure (RPT) documents 

• maintaining up-to-date faculty web pages (e.g., bios, teaching, research interests, 
publications, etc.) directly from DMS 

• providing specialized accreditation reports (e.g., AACSB, NCATE, etc.) 
• providing custom reports for annual program reviews 
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Q: Who has access to my information in DMS? 

A: DMS is used by faculty and college administrators. Faculty can only access their own 
individual information**. Administrators (deans, chairs, and administrative staff) will have 
access to faculty data within their schools/departments only. At the central administrative level, 
select employees in Information Technology and the Office of Institutional Analysis and 
Effectiveness (IAE), with a demonstrated need to know, have access. 

Some schools have also authorized administrative assistants and/or graduate students to enter 
items for faculty. These users will have limitations established that permit access only to 
appropriate faculty within assigned schools/department(s). 

** Exception:  Adding a faculty collaborator on one of the scholarship screens will create the 
contribution on your faculty record as well as the other author’s/presenter’s record. 

Return to FAQs 

VITA 
Q: Can anything be done to change the way certain information appears on the Vita? 

A: Each school has the ability to cater a CV to their particular needs. Recommendations for 
changes to the layout should be forwarded to your school’s administrator.  In the meantime, you 
have the option to generate a Microsoft Word version of your Vita, which can be re-arranged to 
meet your specific needs. 

Return to FAQs 
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SCHEDULED TEACHING 

 
Q: How will cross-listed courses and multiple instructor courses appear in DMS?  
 
A: All basic course information will be imported from the Banner Student system providing the 
course is active and has enrollment.  Courses will appear in the Scheduled Teaching (Banner 
Imports) form in DMS for all instructors of record, with an indicator for primary instructor.  
 
Cross listed courses will appear as two separate courses just as they do in Banner.  A cross listed 
home department field will be used to indicate the course is a cross listed course. 
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SCHOLARSHIP SCREENS 

Q: DMS asks for both a publication accepted date and a published date. Which is more 
important? 

A: Date published.  Faculty must enter, at a minimum, the year a publication was published in 
order for DMS to count the intellectual contribution(s) for year-end reporting, including custom 
reports for AACSB (specific to School of Business).   

NOTE:  For publications in which only the year is listed - with no month - DMS will assume a 
January 1 published date.  For example, consider a paper that is published in November 2010 
(academic year 2010-11). If a faculty member ONLY enters 2010 for the publication date, DMS 
assumes the published to be January 1, 2010. It will then be incorrectly included among work 
published during the 2009-2010 academic year. 

Q: What is the difference between a working paper under Publications and an entry under 
Research Currently in Progress? 

A: "Research Currently in Progress" is designed for a working outline of a research topic you are 
planning to pursue. Once that research is completed and the writing process begins, it becomes a 
"working paper," which should be entered on the Publications screen.  
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Q: I've noticed that some of my citations on Books, Journals and Other Publication 
Contributions were entered by a collaborating faculty member. How does that work? 
 
A: This is a DMS feature known as User Reference.  If you have collaborated with other faculty 
members, the first author to enter the citation can add other authors. When this occurs the record 
displays on your account as:  

Entered By: Smith, Susie  
Title of Contribution  

If the citation requires additional editing, simply click on the Entered By: link to create an email 
to Susie Smith where you can indicate the changes needed.  If Susie Smith has a disabled DMS 
account then you would need to contact your school’s administrator for assistance with editing 
the record.  The system has several other User Reference screens that work in the same manner 
as additional authors on the Books, Journals and Other Publication Contributions screens:  

• Artistic and Professional Performances and Exhibits - add 
Performers/Exhibitors/Lecturers 

• Intellectual Property - add Inventors 
• Presentations - add Presenters/Authors 
• Research Currently in Progress - add Collaborators  

 

Q: “Working Paper” appears as both a “Contribution Type” and “Current Status”.  What is the 
difference? 

A: Commonly, all working papers should be defined in "Current Status" as a "Working Paper." 
When the paper is submitted or published, update the publication record by selecting "edit" and 
choosing the appropriate "Current Status." You do not have to enter the information in a second 
time. You only need to update the status. 

Since DMS assumes that a working paper (even a permanent working paper that never makes it 
to a further stage) counts as an “other” intellectual contribution, "Working Paper" is offered as a 
"Contribution Type." If you are unsure exactly how a working paper will be ultimately used 
(book chapter, article, etc.), set its "Contribution Type" as "Working Paper." If the paper matures 
to a more specific category, "edit" the publication record by selecting the more appropriate 
"Contribution Type." 

Q: What about sensitive or proprietary information or intellectual property? 

A: Other than select pre-populated fields (scheduled teaching from Banner, personal and 
education data), faculty will control the level of detail they wish to have available through DMS.  
If a project is sensitive or proprietary there is no need to include specifics; one can indicate any 
work in progress simply with a general identifying title.  The database will not ask for any 
personal information or confidential information on this screen.   
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Once a Vita or other custom report is generated from DMS, faculty may choose to then edit the 
document with additional, specific details even though they chose not to report those in DMS. 

Therefore, anything that might be considered confidential or proprietary should not be 
entered into DMS without further discussion with your school’s administrator.  Date of 
birth, gender and race are pre-populated in DMS based on Banner data; however, these 
fields will not be reported as personally identifiable information in any public report or 
presentation. 

Return to FAQs 
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